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Version 12.0 Update Supplement
Installing the New Version of Pulsonix
It is always recommended you back-up all libraries, designs, technology files, profile files and report
files before installing the latest version. Other than for any technical reason, this is good working
practice, although you should already have a backup of this data!
To install Pulsonix, double-click on the download executable and wait for a short time. You may have
been supplied a CD, in which case insert it and wait for it to run. The Autorun facility will start the
installation procedure. Follow the on-screen commands from the install wizard. You can install
Pulsonix 12.0 over your existing V11.0 installation. If upgrading from V11.0, you can install it
alongside the older version if you prefer. In any case, you do not need to uninstall the old version first
unless you wish to remove it from your hard drive.
64-bit Installation Folder
By default, Pulsonix V12 will be installed into the programs folder C:\Program Files\Pulsonix12.0
rather than C:\Program Files (X86) which is where the 32-bit applications are installed.
Documentation Installation
The default installation locates all Pulsonix ‘documents’ (Master Libraries, Technology files etc.) is
under user\documents\Pulsonix12.0 rather than being placed in public documents\PulsonixXX

Licensing
Version 12.0 requires a new license if you are a new user or upgrading from any older version of
Pulsonix earlier than V11.0. The new license would have been supplied to you under the terms of
your maintenance contract.
For existing users upgrading from a previous version, it is recommended that you save the new
license in the same location as the current one but make a backup copy first or rename it. When
requested during installation, simply click the No Change In Licensing check box on the licensing
page of the installation wizard. The License Manager can be used to add new licenses and make
changes to network licensing after the installation has been completed.

Version 12.0 Update Notes
The Version 12.0 Update Notes are available in the Pulsonix product installation folder under
\documents. Alternatively, select the direct link within the product itself: Help menu | Online
Manuals> Pulsonix V12.0 Updates Notes. You can also find them on the Pulsonix web site. The set
of notes on the web site will be more up-to-date than the installed version as we are constantly
updating these.
The current and all previous Update Notes are available on the Pulsonix web site under
Documentation.

Pulsonix Version 12.0 Update Notes 7

New In Version 12.0
64-Bit Operation
Pulsonix has been redeveloped as a 64-bit application. As such, it will now be delivered as a 64-bit
only product with no 32-bit application available. All functionality will be the same as previous. This
means, if you have an older 32-bit Windows operating system, you will not be able to install or run
Pulsonix 12.0
With 64-bit, the existing 32-bit address space memory limitation of 4GB has been increased,
effectively removed, with 2TB+ now available. The advantage of this is a performance improvement
for large designs.
NLS Floating license server
The NLS server program has been rebuilt as a 64-bit application but does not need updating for use
with Version 12.0. Older versions of NLS for V11.0 and V10.5 will still work with the new V12.0
clients. A new server license will be required though to run V12.0

Dark Mode UI
A new alternative Dark UI theme is available for selection. This can be easily switchable between
Light and Dark modes.
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As well as the user interface, all dialogs will now be the Dark mode (if Dark mode is selected), for
example, the Technology dialog:

Note, when in Dark mode, you cannot choose Legacy icons, see below, only the Dark mode icon set
will be available.

Switching to Dark Mode
Dark mode is enabled using the Customise dialog and Application Look tab:
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Select the Dark radio button and use Apply Changes to reconfigure Pulsonix to this mode. This not
only enables the dark mode for all dialogs but also swaps out all toolbar icons to a set that is more
compatible with dark mode.
Dark Mode and License Manager
When switching to Dark mode, you will also notice the License Manager adopts the same Dark
style, this is automatic and cannot be switched separately.

Using ‘Light’ Mode
When using ‘light’ mode (Standard) there is now also a new alternative icon set which compliments
the dark icon set. This is a new icon set and is now the default installed set for use. It can be swapped
to Legacy Icons if really required, see below.

Using Legacy Icons
A check box has been added under the Standard look radio button which will set Pulsonix to use the
original, coloured icon set (Legacy Icons). By default, the new ‘light’ set of icons are used in
Pulsonix. The Legacy Icons feature is disabled for the dark mode interface where only the dark icon
set can be used.
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Changes to Customise option
Show/Hide Menu Icons
To aid menu decluttering, you can Show (or Hide) Menu Icons from with the Customise dialog and
Application Look tab. By default, on a new installation, menu icons are shown.

Toolbar Icon Scale Slider
The Large Icons switch in Customise and the Options tab has been removed and replaced with a
slider feature. This can be used when running a 4K monitor and requiring slightly larger icons.
Because the Pulsonix icons are SVG format underneath, they can be scaled and still look usable.
There is now a slider in the Customise dialog and Application Look. This will allow you to change
the size of the toolbar icons displayed to your preference.

The icons below are shown at a scale of 2.00x
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Changes to 3D and STEP
STEP Preview Multi-Threading
STEP file generation now uses multi-threading. It creates components in parallel, and also creates all
items checked in Advanced Settings in the 3D View Settings in parallel. Because of restrictions with
the STEP 3D toolkit used in Pulsonix, multi-threading for this option is hard coded to 3 threads to
protect it.

New 3D Design menu
A new 3D Design menu has been added to bring most aspects of the 3D STEP functionality together
in one location. The original STEP Output is still available on the Output menu in-case you have
accessed it from a Macro and familiarity. This functionality and other STEP options are now only
available on this new menu.
The Edit menu Commands have also been updated to reflect new options access.

You will also notice that some options have been renamed to be more reflective of their use and for
clarity. This menu currently contains STEP features. All other MCAD exports and features, such as
for DXF and IDF are still on the Output menu and other respective menus.
This feature was back-fitted to V11.0 at patch 8466.

3D View tab is now named 3D Packages
The 3D View tab on the Library Manager is now 3D Packages. This reflects is function and storage
rather than its use.
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Mouse Button Change for Rotate in Preview
When in the STEP Preview, you can now press the right mouse button to rotate the board.
Previously, this was Ctrl-right button.

3D Settings Output – Output folder and Design Name
The 3D Settings dialog and Output tab has been changed to add the destination and formatting of the
output files created when using the 3D Design menu and STEP Output option.
This uses the standard file naming conventions used for other existing options, such as CAM Plots
and Reports. You can choose between outputting to the design folder, defining a folder, defining a
folder below the design file, and the general folder. When defining a folder, the arrow to the right of
the control can be clicked to show a list of available tags to use. Click the browse button to search for
and define a folder manually.

This feature was back-fitted to V11.0

The 3D Settings dialog has been reorganised
Below is a summary of the rearranged controls on the 3D Settings dialog. The changes are as follows:
·

Show Exploded View of Layer Stack section has been moved from the Settings tab to the
View tab.

·

Cross Probe section has been moved from the Settings tab to the Interaction tab.

·

Place items directly on-board surface and Only when generating STEP output file have
been moved from the Output tab to the Settings tab.

·

Added the option to define Board (flexi) colour on the Colours tab.

3D Settings - Silkscreen Layer Class
The Silkscreen Layer Class on the Settings page of the 3D Settings dialog has been changed from a
drop-down list (combo box) to a check list box that allows you to enable more than one class to be
chosen to identify the layers for Doc Shapes and Text.
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3D Settings Output - Z-fighting items
To avoid graphical issues (dithering, also known as Z-fighting) when drawing two or more items at
the precise same location in the STEP viewer, components are added to the STEP data using a tiny Zoffset to render them very slightly above the surface of the board. The same is true of additional
design data that might be enabled (such as Pads).
If for some reason you need this tiny offset to be removed so that items are rendered at precisely the
same Z value then two new check boxes on the Settings tab of the 3D Settings dialog allow you to do
this:

The default setting for Place items check box is unchecked. Checking this box enables the next check
box. This second check box controls whether the decision to place items directly on the board is done
in the on-screen preview or only when writing data to a STEP file.
Note that if you check this box there is a performance overhead as the 3D data has to be regenerated
before being written to the STEP file so that items are positioned as required in the correct position on
the Z axis.
This feature was back-fitted to V11.0
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STEP Preview - Multiple boards in one design
The 3D Preview is now capable of viewing multiple boards. For this to operate, boards must be in the
same PCB design, they cannot be separate designs.
To facilitate this new operation, additional features have been added to Pulsonix. These are required
for defining the Board Type, the point of movement on each board (Board Origin), Properties of a
Board Origin from where the X,Y,Z parameters of the moving board are defined and additional
parameters in the 3D Preview
Insert Board Origin
Insert Board Origin: A Board Origin or rather a pair of board origins, are used as the point of
positioning from one board to another. The ‘placed board’ origin (the one moving), can contain
Properties for folding, see below.
If there are only two Board Origins, these will be paired. If you have more than two boards that need
to be folded, then add more pairs of Board Origins. In this case, you will need to name them so that
the correct ‘pair’ are matched. For example, on three boards that should be folded together, you
would have two pairs of Board Origins.
To access this new command, it is not on the main menu so right-click on the Board Outline and
select Insert Board Origin from the context menu.

This allows you to place an origin marker that belongs to the board outline. Place one on each of your
boards (optionally naming the origins to ensure that the correct ones are paired). These act as the
points which are automatically brought together when the board is ‘folded’.
In order to position the board, the Board Origin has a set of its own Properties. With the Board
Origin Properties dialog, you can set the name (optional), set the XYZ offsets, set the XYZ
rotations.
The Increment entry allows you to changes the 'step' that is applied when you click one of the
spinners for X, Y or Z. This provides a more efficient way for you to state that you want to step in
increments of say 0.5 instead of whatever value we choose. Most spinners used are for integers so it is
easy to step up/down by 1, but these are floating point numbers so the preferred step could be just
about any number.
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By specifying rotation and/or offset, this allows the moved board to be further positioned after it has
been automatically aligned based on the pair of board origins. For example, to turn your secondary
board over and ‘hover’ it above the main board, specify a Z Offset of say, 9mm and a Y rotation of
180.
Note, the Name used on this page is only the Board Origin Name, not the Board Name.
Board Properties for Board Outlines
There is now a Board properties page in Properties which can be accessed when a single board or
multiple boards are selected. This page contains controls for Board Name and Board Type, taking
values of Rigid Fixed, Rigid Moving, and Flex (although this one is not currently used anywhere).

The Board Name helps you identify it. This name is not related to the Board Origin.
The Board Type is used when moving/folding the board in the 3D Preview. If Rigid Fixed, it will
not move and would be considered the ‘master’. If Rigid Moving, it can be moved and the
parameters on the Board 3D Origin page will be used.
3D Settings - Board Folding
Once multiple boards have been created, Board Origin pairs defined, Board Types defined and Board
3D Origin folding parameters set (so the folding knows how much and where to position the board)
you can now view the boards in the 3D Preview. Once in this editor, you can then perform the
folding.
The new Fold Board command on the Tools menu is used to move a rigid Moving board to another
defined position (from Board Origin and Board 3D Origin).
Selecting this tool causes the moving board(s) to be aligned/transformed as defined by the paired
board origins. Everything inside the moved board (components, tracks, pads, etc.) will be moved in
the same way so they move with the board. Invoking Fold again will toggle and ‘unfold’ the moved
board back to the initial state as generated from the 2D PCB.
Note: when folded, components currently cannot be moved, this can only be done when in the
unfolded state.
Also, the design will not be displayed folded if Exploded view is selected.
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3D Settings – Clash Detection
Clash Detection will work as before, and flag any clashes where components violate each other.
However, if you have situations where you explicitly want items to touch (e.g., where a plug on the
moving board fits into a socket on the static board) you can add a new attribute 3DIgnoreClash. This
should be added to one of the components that will be violated with a value of the component name
of the other component (or a valid component name-range including comma separated names).
When the Clash Detection option is then run, the component will be ignored.
STEP Component to Board clashing
The Detect Clashes option in the STEP 3D Preview now can perform Component to Board
clashes. This clash detection is required for checking clashes between the static and moving boards
when using the Fold option. When folded, there is a possibility that the static board will clash with
the moving boards’ components, and vice versa.
To enable this clash detection, check the Component To Board check box in the Clash Detection
section of the 3D Settings Interaction page.
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3D Settings - Board Differentiation Colours
Colours Board (flexi) - option to define Board (flexi) colour on the Colours tab, the board type
must be set to Flexi for this to be visible.

3D Settings – Cross Probe
Two new check boxes on the 3D Settings and Interaction page have been added. These will enable
Cross Probe in each direction between 2D PCB and 3D views. Clicking on items in one will select
them in the other.
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Inspector Bar – Board Group
A Board Group has been added to the Inspector Bar.

Limitations
Cannot import a STEP assembly on another board type for ‘folding’.
No connection or bended flex is shown between boards and there is no animation when folding.

Changes to Library functionality
Part Editor - 'Map Multiple PCB Pins'
Within the Parts Editor, when editing a Part, the function Map Multiple PCB Pins is now also
available on Edit menu. This is in addition to it being available on the context menu on the selected
Pin Names cell on the Gates tab.
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Change Part Type of an Associated Part
In the Part Editor you can now change an Associated Part to a Normal Part. Select the Change
Part Type option from the Edit menu whilst editing an Associated Part.

Note, this option already existed for changing a Connector Part to a Normal Part but has not been
expanded to include Associated Parts.

Part Edit – Force Display of Attributes
When editing a Part, the Force Attribute Displayed dialog (from Edit menu) now includes two lists
for you to define which attributes you want to force displayed when adding the Part to a Schematic or
PCB design. This feature is particularly useful if you have imported a design from another product
and wish to force specific attribute fields on.
If the attribute is not already on the symbol, the attribute positions will be added underneath each
other in the order from the list. The order of the list can be adjusted using the Up and Down buttons
under the Force On name column.
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The Force On list is populated with attribute names that have already been used on the Parts and
Attributes page of the Parts Editor for the Part being edited.

This feature was back-fitted to V11.0 and V10.5

Multi-Threading for Find Part in Library
The Find Part option on the Parts Library tab has been speeded up with the use of Multi-threading.
This is only available when finding Parts in all libraries (not for single library find).

Multi-Threading for Find on the Insert Component option
The of Multi-threading has been added to the Insert Component dialog, Find option. This will speed
up the searching but is only available for all Parts and not single libraries.

Multi-Threading for Library Indexing
Multi-threading can now be used for library indexing. This is only available when indexing all
libraries and not for single library indexing. This feature is available when multi-threading is enabled
in the Options dialog and General page.
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Change Part Dialog - Same Symbol filter
A Same Symbol filter has been added to the Change Part dialog when in schematic designs. The
check box is used to limit the matching Parts to those that have the same symbol as the Part you are
changing. This option is only available in schematic designs, and for Parts with a single gate.

The symbol name has been added to the Part library index if the Part only has one symbol. When
filtering by symbol in the Change Part dialog, if the symbol field is not currently in the library index
for the selected library or libraries, it will be rebuilt.
This feature was back-fitted to V11.0

Blue and underlined hyperlinks in Part Browser & Insert Component dialog
Hyperlink attributes in the Part Browser and Insert Component dialog attribute details pane are
now shown in the standard link format (blue and underlined) to make it easier to identify them as
clickable links.
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New Mode for Type Rotate
The Type Rotate dialog now has a new Rotate About option named Each Item About Its Own
Origin. This will rotate each of the selected items (apart from tracks and connections) about their
individual origins rather than rotating the selection as a whole.
This is useful where footprints in the library have been changed and they should be rotated in the
design after an update.

Move item(s) Onto Grid option
There is now an option on the context menu for selected items to move onto the grid, named Move
Items Onto Grid. Each selected item will move to the closest point of their appropriate grid (the
current Interactive Grid).

If a track is selected it will not be gridded unless only a single track segment is selected. The track
segment will move onto the grid based on its orientation.

Performance Improvement – Interrupt for design clearance
The performance has been improved when moving very large components with Online DRC and
Draw Clearance enabled, and Show Weld Spots. The time taken to calculate their design clearances
(if enabled) has been improved.
This feature was back-fitted to V11.0
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New highlight Colour for Components Not Fitted in any Variant
Similar to the Not Fitted highlight colour. The Not Fitted In Any Variant option will have a
different colour for a component which does not have a variant assigned to it.

Variant Manager – Delete Unused Components or Unfit option
Within the Variants Manager in the Technology, using the Delete function now allows you to
decide to delete unused components or just unfit them. A warning dialog appears showing three
buttons.

Delete, will delete the components from the design,
Unfit will unfit these components from all variants, but will remain in the design.
Cancel will cancel the delete and return you to the Variant Manager dialog.
Report will generate a list of components that are in the soon to be deleted variant and not in any
other variant.

Reload Block - Preserve block instance variant
When Reloading Blocks, there is now a special option named Preserve block instance variant
which when selected, preserves the Fitted/Unfitted status of Components in the block.

Note: This switch is only visible and only applies provided ALL Components in the block have
the SAME status.
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New Design Setting to allow Pad Exceptions to ‘Move with Buried Component’
A Design Setting on the General page to allow Pad Exceptions to Move with Buried Component
has been added.
This allows the Pad Exceptions to follow the buried component as it moves down the layer stack. For
example, a Solder Paste exception on the Top Solder Paste layer would appear on the Solder Paste
layer associated with the top facing layer a buried component is placed on.

Properties - Override Land Suppression on individual Pads and Vias
In Properties on Pads, Mounting Holes, Vias or Micro-Vias, unchecking the Allow Suppress
Land switch overrides the Suppress Unconnected Land flag on the layer (Suppress Unconnected
Land is defined on the Layer page in the Technology).

Deselect on all pages option in Schematics
There is a new setting in Options – Select, under Deselect for Deselect Items On All pages. In a
Schematic design, selecting this option changes the deselect all behaviour to deselect everything on
all pages of the design.
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New Pour All Templates Command
A new Pour All Templates command has been added. This is available on the Utilities menu.
Selecting this option will pour copper into all templates on all layers using the pour order if defined.
This command is also available on context menu with nothing selected in the design.

New Insert commands available – Ellipse, Spline, Wave
New commands have been added to the Insert menu and various insert commands to add Ellipse,
Spline and Wave shapes.
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These shapes can be added to the following:
Board
Copper
Shape
Area
Construction Line
Track

Ellipse
Ellipse
Ellipse
Ellipse

Spline
Spline

Wave

Spline
Spline

Wave
Wave

Splines
After selecting Insert Spline shape from the Insert menu, you draw the start and end point of the
shape. The shape Control Points are then added; as many as required. The shape created is then save
in the design as a controlled shape, meaning it retains the control Point handles for future editing.
Control Points are used to bend the curve towards it.

Control Point handles are available when adding or editing splines.
Single press a position on the design to place the start of the spline.
Single press another position on the design the place the end of the spline.
Begin adding Control Points by single pressing onto the design - the spline shape that fits through
the points will be generated dynamically to show what the finished shape will look like.
The order of the Control Points can be reversed during this stage if they are not in the expected
order. Reverse the control points using the Reverse Inner Control Points command from the context
menu.

Double click or use the Finish Spline command from the context menu to stop placing Control Points
and enter the edit state.
If you edit a spline and single click on a Control Point (the small square box), from the context menu,
you can Refine the Control Point to a different location, Delete the Control Point or Insert
Control Point.
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To use Delete or Insert, edit the shape, then left click on the small square you wish to edit and right
click to reveal the context menu. Inserted Control Points are added after the one you have selected.

As an alternative, you can add a Construction Line Spline to the design and use Follow
Construction Line from the context menu when adding a new shape, a Track for example.
Merging Splines
As with all controlled shapes (splines, waves, serpentines), you cannot use merge on them. If you
wish to connect two splines, use a short track segment, and then overlay the two ends of the splines to
create a zero sized track. Ideally, you would create one spline of the full shape required.
Spline Segment
With a track segment selected, from the context menu you can select Spline Segment. This will split
a track and insert a spline using the start and end points of the selected segment.
Converting a Track Segment to a Spline
With a single track segment selected, the Spline Segment command on the context menu can be
used to turn that segment into a spline. The start and end points of the spline will already be placed at
the start and end points of the selected segment.

Remove Spline Shape
For a select a spline shape, from the context menu you can select, Remove Spline Shape. This
command removes the spline-controlled shape and reverts the shape to a straight line between the
start and end points. Once this has been done, it cannot be made back into a Spline (other than if
Undo is available) without recreating it.
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Waves

When adding or editing a Wave shape, a dialog is displayed from which to choose the wave
characteristics:

Select the required parameters and then press OK. The wave shape will appear on the cursor and you
can place the wave where you want. If the wave does not look correct, you can cancel the operation.
This will return you to the dialog and you can adjust the parameters. When placing a Track, you can
use the auto weld feature to connect the wave to a pad or via as you place it. You can Rotate or
Mirror the wave as you place it.
Wave Dimensions

The Length is the total width of the wave shape.
The Phase is the offset which is used before the wave begins. This can be used to create cosine waves
by using a Phase which is exactly half of the wave length where wave length = Length / Periods.
The Amplitude is the height of each crest/trough from the centre line of the wave (y = 0).
The Periods defines how many periods of the wave are fitted into the total Length of the wave.
Segments Per Period – this alters the accuracy of the wave. A higher value will create a more
accurate wave by increasing the number of straight segments in each period.
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Below are some examples showing how wave forms are changed by altering the available parameters:

Ellipse

From the Insert menu, select Board, Shape, Area or Construction Line, and the Ellipse option.
At any point during the creation or editing of an ellipse, the Enter Ellipse Parameters command can
be used from the context menu. This will display the centre position, angle, and two radii of the
ellipse, as well as bypassing the interactive creation of the ellipse. You can edit these values for the
ones you require.

Start the Ellipse shape manually, select the start point in the design using the mouse.
·

Move the cursor to define the size of the First Radius as well as the Angle of the ellipse.
An ellipse can be defined from the centre or edge to edge by toggling the Define from
Centre command in the context menu.
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·

You can move the cursor in any direction but will be constrained to 45-degree angle steps
unless the Free Movement command is toggled in the context menu.

·

Single press to finish defining the First Radius and the Angle.

·

The Second Radius of the ellipse will then become active and allow changes. Again, this is
done moving the cursor. The radius will be equal to the distance from the centre of the
ellipse to the cursor.

·

Press the mouse to finish defining the Second Radius.

After the two radii and the angle have been set, the ellipse can be edited. Four handles will appear on
the perimeter of the ellipse, which can be dragged with the cursor to change the corresponding radius.
The centre handle can be used to move the ellipse while in the edit state.

A handle may be selected by selecting it with the mouse. A handle will become highlighted, along
with the one opposite, to indicate that it is selected. With a handle selected, the commands Enter
Radius and Enter Diameter will be available from the context menu and can be used to manually
enter the size of the radius.
The angle of the ellipse can be modified in the edit state by using either the Rotate About or Enter
Angle commands. The Rotate About command will cause the ellipse to rotate towards the cursor
similar to how it does when first creating the ellipse.
The two radii and the angle are displayed in the Status Bar to show the ellipse's dimensions during
creation.

Changes to Existing Spiral Shape Algorithm
The existing Spiral shape has been changed with a new algorithm for calculating the spiral.
Previously, the spiral was generated using approximated ‘half’ circles that offset each other. The use
of the new Archimedean algorithm generates a more accurate and smoother spiral.

If you wish to use this new algorithm, then you will need to remove, then recreate the existing spiral
shape. The shape is not regenerated automatically. Unlike the existing shape though, the new shape
style will be retained and can be re-edited afterwards. The old shape was a one-off and not editable.
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Insert Bus Route Changes
There are two changes to make bus routing more efficient:
The Define Bus Route Nets dialog will now change to Define Bus Route Nets and Layers
when Use Multiple Layers is selected. The dialog then includes a Layers column so that the
layer for the track can be defined.
Insert Bus Route will now make use of Breakout patterns on pads.
Layers column in Define Bus Route Nets dialog
With the Use Multiple Layers selected, when using the Define Bus Route Nets and Layers dialog,
either to choose the nets to be included in the Bus Route or after picking the pads/connections to be
included, there is now a Layers column in the dialog presented to define what layer you want each
net to be routed on. This enables you to route sub-sets of related nets together on different layers
which makes it easier to route out of BGA patterns and keeps the Bus Route Trunk width to a
minimum.

The track segments will be added interactively on the multiple layers at the same time, online DRC
will apply on all layers being used.
Finishing the Bus Route will result in separate Bus Routes being added on each layer involved. These
can then be edited separately.
If the multi-layered bus routes are finished in space, they can be continued using the Insert Bus Route
option by framing the dangling ends.
Use of Breakout Patterns on Insert Bus Route
When the Insert Bus Route option is selected, it will route the gathering stage (the initial phase of
‘starting’ the routing) of the chosen tracks in the bus route from tracks and vias created from the
breakouts on the footprint pads (as created in the Footprint Library). It will also make use of
breakouts when completing the Bus Route at the target end, thus making it easier to add Bus routes
between BGA devices.
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Changes to Construction Lines
With the addition of the new shape types to Construction Lines (Ellipse, Spline and Wave) (see
above), this introduces new concepts to the option. Spline and Wave shapes are effectively ‘local’
Construction Lines and not just ‘infinity’ lines (although Circle Construction Lines technical are too).
With the addition of Spline and Wave Construction Line shapes, you can use this as any other
Construction Line shape in that you can add Copper and Tracks for example along them.

Text Search in Find Bar
A Text search has been added to the Find Bar, this can find all ‘free’ Text and Attribute text.

Find ‘Type’
Type text to find here
Recent Searched list
Choose Text in the Find Bar as the ‘type’ and enter the text to find in the box. As you search for
different text items in your design, the searched list will be populated. This can be refined using the
Delete Search option from the context menu on the selected text string.
Note, to find Component Names, like, R1, C1 etc. choose Attribute Text.
New options on the context menu are available for Find Text.

This option can also be used to search for attribute values by selecting the Attribute Finder from the
context. You must select the Find Displayed Attribute Value if you wish to find an Attribute text.
Context menu commands
Delete Search - Deletes the selected search from the list.
Delete All Searches - Deletes all previous searches from the list.
Find Exact Text - Only text matching the exact search string will be found.
Open Wildcard Wizard... - Use this to add wildcards to the search string. Only enabled if Find
Exact Text is disabled.
Find Displayed Attribute Value - Use this to find displayed attribute positions with a value
matching the search string. This is automatically deselected if Find Item Attribute Value is selected.
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Find Item Attribute Value - Use this to find items with attributes containing a value matching the
search string. This is automatically deselected if Find Displayed Attribute Value is selected.

Change ‘open’ Copper to Track and vice versa
The ability to change an ‘open’ Copper Shape to a Track has been added.
To use this option, select an ‘open’ Copper shape, right click and from the context menu, select
Change Shape Type, choose Track from the drop-down list.

This can only be done if the selected shape is not a controlled shape e.g. spline.
The reverse can be done to convert a Track to Copper.

Area Mounting Hole Keep Out/In
Properties of an Area has been modified to allow Mounting Holes as keep In/Out.

This new type will be included in the Design Rules Check for Keep In/Out rules under Component
Mount Hole.
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Remove from Group when multiple items are selected
The Remove From Group command is now available when multiple items are selected within a
non-Tight group. It will only appear when components are all in the same group. If a component is
part of multiple groups it will only be removed from the group common to all selected components.

Match Rotation/Mirror of previous Component from Bin
When you drag a component from the Component Bin, its rotation will now match the last component
of the same type dragged from the Bin. In previous releases, the rotation was not considered for any
component.

Auto Rename - Padded with zeros
When using Auto Rename, the new name can be padded with zeros, so all the name lengths are the
same. This can be achieved by checking the Pad With Zero box and setting the number of zeros for
padding. For example, a resistor with Pad with Zero set to 4 would become R0001.
The only instances where this doesn’t really apply is when the padding is set to a low number, such as
2, and the names could be more than 3 numbers, for example, C01, 02 to 99 and then C100 The
lengths are now not the same.
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New ‘Replicate Shape As’ feature
There is a new command, Replicate Shape As, that works similar to Change Shape Type, but
instead, keeps the original shape.
To use this option, select a shape, choose the Replicate Shape As command from the context menu
and then choose the New Type and Layer. The shape will be copied to the new layer and shape type,
and will use the same shape position.

Star Point Design Settings Defaults Changed
Star Point Design Setting defaults has been updated to include a Change Symbol button and a
Name Stem.

Highlight Net includes Star Point
In PCB designs, highlighting a net now also highlights Star Points on that net.
Find Bar options (Select, Highlight, Brighten, etc.) will also be applied to Star Points when
searching for a net.
The Mark Net option now marks Star Points on the net.
Mark Net can be used when a Star Point is the selected item (in PCB). If the Star Point is on more
than one net, the Choose star point net dialog will appear, allowing you to choose which net to
mark.
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Option to Synchronise the Document Title & Subject
In the Design Settings and Synchronisation, you can select the Apply Schematic Title & Subject.
This will allow the Title & Subject to be synchronised between your designs.

Option to Suppress UTF-8 BOM used in PLM and Scripting
A new check box has been added to the Options dialog and General page to Suppress UTF-8 BOM.
Checking this option will prevent the byte order mark from being written to an output file. The check
box is set as unchecked by default to prevent interference with current settings. If you wish to use it,
you should check this option to enable it. This is required by customers using PLM software and
Pulsonix scripting that writes a BOM which can cause an error when being read in. The file can be
encoded with UTF-8 rather than UTF-8 with BOM.
This feature was back-fitted to 11
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Toggle Layers
Redesigned Toggle Layer dialog
The Toggle Layer dialog has been revised to make it less programmer and more user-friendly.
The changes reflect the Technology dialog layout and use a grid to contain the different toggles, this
includes the Toggle Layer, Name and Rule.

Three new buttons on the right side are used to manage the different toggles; create a New toggle,
Copy and existing one and Delete a toggle layer.
Below the grid there are various controls under Layer Visibility Rule, that help you to construct
and/or edit a layer command with all controls shown (but enabled and disabled accordingly).

Index is available if the Side is selected as Inner. This will be a numeric value that refers to the Inner
layer in the sequence it appears (in the Inner Layers list). It might be a more suitable alternative
choice when specifying a specific inner layer (rather than all inner layers) to use a named layer
command instead.
Omitting the Index when specifying Inner implies ALL inner layers, so "Electrical Inner" will toggle
all the inner electrical layers.
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There is also a list box that shows all of the layer commands within a toggle (each printed on a
separate line) allowing you to easily select and edit layer commands by clicking on that layer
command in the list. There are also 4 new buttons that help manage the list of layer commands.

Switching Multiple Layers On And Off Simultaneously
Use the check box Opposite Toggle to visibly switch a layer the opposite way to the first layer
specified.

Where multiple layers are specified for a single Toggle Layer command, it is possible to
simultaneously turn some of them on and some of them off thus allowing 'sets' of layers to be visibly
switched. To achieve this, any layer to be switched the opposite way to the first layer specified should
be followed by the word off. For example, defining Toggle Layer 3 as "Electrical Top, Electrical
Bottom, Electrical Inner off" will allow the top and bottom electrical layers to be made visible and at
the same time, all inner electrical layers to be made invisible. Using the Toggle Layer 3 command
again will have the reverse effect.

Layers Bar – Create Layer Toggle From Selected Layers
From the context menu on the Layers Bar, a new, Create Layer Toggle From Selected Layers
option has been added.
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When selected, the currently selected layers in the bar will be added to a new Layer Toggle layer
with the action ShowEx. This means that when this new toggle is clicked in the Layer Toggle Bar,
only those selected layers will be shown, everything else will be hidden.

Technology Dialog Changes
Grids Page - Apply Origin Settings To All Grids
The Apply Origin Settings To All Grids check box is now a push button instead of a check box. The
button is disabled if all grids have the same origin.

This feature was back-fitted to V11.0
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Spacing rules - Design level - Pad - Suppressed pads - Additional spacing for Drill Holes
On the Spacing Rules under Design Level and Pad, an additional spacing around the drill hole of a
suppressed pad can now be defined.
This is in addition to the spacing derived between the pad item (Pad, Mounting Hole or Via) and the
other item. This is instead of the two options, Check suppressed pads as though pad is there, and
Use suppressed pad spacing shape.

Component Colour Rules
A new tab in the Colours dialog has been added for Component Rules. This tab is essentially the
same as a rules page except it is used to define colours for Component Symbol Shapes and/or Text.
This means it can be used in a Schematic for example, for colouring all two-pin devices as solid.

The Schematic Colours page for Component Rules allow you to Match parameters based on the
Attribute as you do with any other rule.
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The <Pin Count> attribute type is available to enable components so be matched to a rule given the
number of pins.
The PCB Colours Component Rules has slightly different combinations and Layer selections:

The new rules can be used in both PCBs and Schematics but have different options for each.

Minimum Pad Land for Mounting Holes
You can now define the Minimum Pad Land for Through Mounting Holes by selecting them on the
Pad Type drop down list under Technology, Spacing Rules, Design Level and Component tab.

No Same Component Pad to Pad Errors extended to include Mounting Holes
The No Same Component Pad to Pad Errors option under Technology, Spacing Rules, Design
Level and Component tab now includes Mounting Holes.
The No Same Component Pad to Pad Errors option check box is used to ignore pad to pad errors
within the same component footprint (or documentation symbol), but now also includes mounting
holes.
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Suppress Pads on Outer Layers
You can choose to suppress unconnected lands on through hole On pads, On Vias or On Micro-vias
on an electrical layer.
There is a new separate option to override the land suppression when on the Outer (top or bottom)
layer of the span for Vias and Micro-vias. A land is unconnected if there is no track to it on that layer
and it is not contained in a template of the same net, on that layer. The land is not drawn and will not
be plotted.

Anti Pad Rules
The Anti Pad Rules dialog is used to specify the rules used to generate additional copper plane
cutouts on layers below pads (or vias, mounting holes, etc). When copper is poured, or a powerplane
generated, these cutouts are applied. This rules dialog allows the cutouts to be auto-generated.
There is a new page in Technology under DFM/DFT for Anti Pad Rules.
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This is a specialist feature and won’t be generally used by most users. It is used for high-speed
designs with GHz signals. This is necessary to avoid parasitic capacitance. In some cases, the whole
component area needs a cutout, the rules page allows this.
Below are some reference links regarding this topic:
http://www.ti.com/lit/an/snla074a/snla074a.pdf?ts=1591360735180
https://docs.broadcom.com/wcs-public/products/application-notes/application-note/980/533/av020725en-an_5362-27jul10.pdf
https://www.amphenol-aerospace.com/resources/literature/view/r-vpx-routing-guidelines
This feature is fully described in detail in the online help.

Associate a layer with a different non-electrical class to Swap With
You can now associate a layer with another layer of a different Layer Class. Previously, this was not
allowed and only matching Layer Classes could be swapped.
In the Technology Layers tab, it shows the layer to Swap With. If there is not an equivalent layer of
the same class, you can associate a different Layer to swap with. This allows you to have different
layer class settings on the ‘other’ side.
In the example below, Silkscreen Top and Silkscreen Bottom have different Layer Class names
(each class containing different contents). The Swap With setting enables you to associate them
without error.
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Match Pair Spacings for Diff Pairs, Signal Paths and Sub Nets
You can define Match Pair Spacings for the Attributes <Differential Pair Name>, <Signal Path
Name> and <Sub Net Name>, as well as user defined Diff Pair, Signal Path and Sub Net attributes.

These defined spacings will produce valid errors when running batch DRC, and also when using
Online DRC (with continuous Online DRC backing off from possible errors).
The Rule and Spacing controls on the Measure dialog Gap tab take into account these new Match
Pair Spacings as well.

Copper Pour – Keep Touching Copper
Copper is normally considered not isolated if it touches another piece of copper on the same net. This
changes the results in some cases, particularly when using nested templates on the same net.
There is now an option in Technology on the Copper Pour Rules to make it Keep or remove the
copper - Keep Touching Copper.
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The images below show two overlapping templates, before pouring:

And after pouring with the Keep Touching Copper switch checked, he two shapes are poured
touching (connected).

As a comparison, this is after pouring with the Keep Touching Copper switch unchecked:

This feature was back-fitted to V11.0.

Define Teardrop by Length
The teardrop size can now be defined by its length from the edge of the pad.
Where a teardrop is on a round pad for example, it can be too small when the V Angle is set to 90
degrees (with the angle determining the teardrop length), this feature helps eliminate this issue.
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The length can be set in the Teardrop Rules in the Technology. This will be enabled by selecting the
Use Length check box. The default length is 50 thou or metric equivalent. With Use Length selected,
the V Angle setting is deactivated.
The length can be set on the Properties of Teardrop for a selected teardrop. This can also be used to
toggle between defining size by V Angle and Length (as well as the Shape style).

Loop Antennae Rule
A new rules page has been added to the High Speed section in the Technology for Loop Antennae.
It will only be available if you have the Interactive High-Speed option and license.
This rule and subsequent DRC process, will check for closed and/or open track loops. You can also
define a minimum distance for open loops which is the minimum spacing needed between the two
tracks to not form an open loop.
A closed loop is formed when two tracks attached to a via on different layers overlap (i.e. they cross).
An open loop is not a complete loop (closed) but still forms a loop area.

The appropriate Loop Antennae rule is found for each net item by working down the list of rules
until the first match is found. Hence, the order of the rules is important. A match is when the specified
Attribute Name and Match Value match attributes of a net item. The Loop Antennae rule must have
the given attribute, and its value must wildcard match the value.
Closed Loops defines whether or not to check for closed loops.
Open Loops defines whether or not to check for open loops.
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Min Distance defines the distance required between a track across layers to not form an open loop. If
the distance between any two segments across layers is less than this minimum distance and greater
than zero, then an open loop is formed (a distance of zero would form a closed loop).
Design Rules Checking
The Loop Antennae check has been added to the Net section in DRC (which produces the LA error
code if in error).
This check finds closed and/or open loops (as defined by their rule) formed across layers without an
intervening copper plane which covers the loop area.

Stub Routing Length Rule
The Stub Routing Length rule has been added to the DFM/DFT rules in the Technology. From
here, the maximum length is defined between the pad and the first track junction or via it comes to.

Design Rules Checking
The Stub Routing Length check has been added to the Net section in DRC (which produces the SR
error code if in error). This check ensures the routed distance from the edge of a pad to another node
(junction, pad, via etc) is not greater than the defined maximum value.
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Track Mitring Rule
Two new rules for Is Mitred and Is Curved have been added to the Track & Via Size Limit page
under DFM/DFT Rules in the Technology. This rule allows you to define whether all corners on
rule-matching tracks are mitred, and can also ensure all mitres are curved.

Design Rules Checking
The Track Mitring check has been added to the Net section in DRC (which produces the TM error
code if in error). This check ensures all corners on matching tracks are mitred, and can also ensure all
mitres are curved.

Return Path Rule
The Return Path rule has been added to the High-Speed rules section in the Technology. It will only
be available if you have the Interactive High-Speed option and license.
This rule and DRC check ensures that track is covered by copper on defined reference layers (Above
and/or Below the signal layer), and is greater than the defined minimum distance away from the edge
of the copper (Min Gap).
You can also choose to Exclude Pad Voids which, if enabled, will not take into account Pad (or Via,
Micro-Via or Mounting Hole) cutouts in the reference copper and it is on the same net as the track.

If there are any holes in the copper covering the track (could be made by a Pad cutout etc.) then a
return path error will be found if the track is within the minimum distance of the hole. The Exclude
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Pad Voids check box will not give an error if the item creating the hole is on the same net as the track
(so a pad on the same net creating the hole).
Design Rules Checking
The Return Path check has been added to the Net section in DRC (which produces the RP error
code if in error). The copper (and pad) are on an adjacent reference layer to the track (Above and/or
Below the signal layer). The check is to ensure the track is completely covered by the copper, and you
can define a minimum distance to stop the track from getting too close to the edge of copper.

Copper Check Rule
A new rules page has been added to the DFM/DFT section in the Technology for Copper Check.
Copper ‘sliver’ are as long, thin, dangling sections of copper that can cause issues during
manufacturing. When creating high frequency designs, it can also act as a net antenna at certain
frequencies.

This rule allows you to define parameters used to check for various sliver conditions. Although the
width of a Pour Template Area will control most of these parameters, this rules page enables you to
define and check them before plotting the design. Sometimes, slivers can inadvertently be created
following pouring without knowing.
Min Copper Width is used to define the width of copper between two items, such as a pad cutout
and another items’ edge.
The Min Copper Angle is the minimum required angle between two copper segments to avoid a
sliver being created. The angle between two joining segments has to be greater than this defined
angle, otherwise an error will be found.
The Min Sliver Width is the smallest width possible for a section of copper to not be classed as an
antenna. The Max Sliver Length is the longest the section of copper can be before it acts as an
antenna.
A copper sliver will be a section of copper that is thinner than the minimum width and longer than the
maximum length.
Design Rules Checking
The Copper Sliver check has been added to the Manufacturing section in DRC (which produces the
CoS error code if in error).
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This check returns an error if the distance between two copper cutouts (these cutouts can either be
manually inserted cutouts, or cutouts around items when the copper is poured) is less than the defined
value. For positive copper, the cutouts in the copper are also checked against the edges of the copper.
For negative copper (powerplanes) all the openings around items are checked.

The Minimum Copper Width check will report an error code CoW

Minimum Text Size Rule
A Text tab has been added to the Additional Design Level Spacings and Rules section in
Technology Design Level Spacings.
The minimum text size required for you design can be defined in the Text Size section. This prevents
you from potentially creating a text size that is either unreadable or not manufacturable.

Design Rules Checking
The Minimum Text Size check has been added to the Manufacturing section in DRC (which
produces the TS error code if in error). This check ensures all text in the design is larger than the
defined minimum size.

Min Solder Mask Width Rule
A Min Mask Width value has been added to the Layer Class dialog in the Technology. This defines
the minimum solder mask width required. This value can only be defined on Non-Electrical layer
classes.
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Design Rules Checking
The Solder Mask Width check has been added to the Manufacturing section in DRC (which
produces the SMS error code if in error). This checks there is a minimum width of solder mask on
any layer with a Non-Electrical Layer Class across the entire board that has the Min Mask Sliver
defined.

Solder Mask To Track Rule
A Min Mask to Track value has been added to the Layer Class dialog in the Technology. This
defines the minimum solder mask to track width required.

The solder mask to track check will check any layer with a layer class that has the Min Mask To
Track value defined (this value can only be defined on Non-Electrical layer classes).
Design Rules Checking
The Solder Mask To Track check has been added to the Manufacturing section in DRC (which
produces the SoT error code if in error). This check ensures there is a minimum distance between a
track and a solder mask opening (not including the opening for the tracks start and end nodes if they
exist).

52 Pulsonix Version 12.0 Update Notes

SMD To Corner and SMD To Plane Rules
The SMD rule has been added to the High-Speed rules section in the Technology. It will only be
available if you have the Interactive High-Speed option and license. Within this, two new rules have
been defined:
SMD To Corner check
Using the SMD To Corner rule, you can define a minimum length of routed track measured from the
edge of the SMD pad to the first corner of the track.

Design Rules Checking
This check is used by the Online DRC when adding Tracks to your design and when running the
batch DRC option.
The Solder To Corner check has been added to the Manufacturing section in DRC (which
produces the SM-Cnr error code between the SMD pad (edge) and the corner if in error).

SMD To Plane check
This new rule allows you to define a maximum routing length from an SMD pad to a Via (or MicroVia or pad) that is connected to a power plane.

This distance takes into account the thickness of the board between the current layer and the power
plane layer. The rule can be defined for a Net or a Pad style.
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Check All Connecting Copper
Checking this option causes layers with a Routing Bias of Power Plane, and poured copper to be
taken into account when checking To Plane Max Length. Unchecking this option will cause only
layers with a Routing Bias of Power Plane to be checked.
Design Rules Checking
The SMD To Plane check has been added to the Nets section in DRC (which produces the SM-Pl
error code between the SMD pad and the plane if in error).

New System Attributes Available
Added Last Saved Author Attribute
The system Attribute <Last Saved Author> can now be added. This can be used for showing the
author on a drawing blank for example.

Added Last Saved Year attribute
The system Attribute <Last Saved Year> can now be added. This can be used for the copyright
string for example.

New in-build attribute of <Not Fitted In> added
A new system attribute of <Not Fitted In> has been added for use with Variants. This is the opposite
of the existing system attribute <Fitted In>.
When creating variants, it is sometimes advantageous to display the Variant that a component is not
fitted in to highlight its status.

Attribute Validation when adding a Component
Using the Attribute Validation switch, attributes are now validated when a Component is added to
the design.
When used, it issues a warning message which can be turned off if required.
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Additional DRC Checks
Silkscreen Overlap Doc Shapes
The Silkscreen Overlap check under the Manufacturing checks in DRC was available in V11.0 but
it didn’t take into account Doc shapes on a Silkscreen layer with overlapping pads. It does now and it
will display an error when DRC is run. Before the Silkscreen Overlap check, it would only check for
text on a Silkscreen layer so this expands the DRC for these items.

This feature was back-fitted to V11.0

Check for Modified Templates
A new check for Modified Templates has been added to the Manufacturing section in DRC.
When run, this check will give an MT error if a template has been modified (i.e. the template shape
has changed, items inside template have changed or moved etc.) but the template has not been
repoured. This check should be used when Repour Affected Templates is disabled.

DRC Dialog – Shows Errors Bar can now show Fully Expanded Bar
When running the DRC option, there is an additional switch under Show Errors Bar, if when checked,
enables you to Fully Expand Bar. This enables you to see all the error markers for all the layers and
categories without requiring to expand each one.
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Apply Layout Pattern – Type Final Position
A new option in Apply Layout Pattern called Type Final Position, enables you to type in the
coordinates of the final position of the pattern.

You will be prompted once the layout process has finished, you can still place manually if you cancel
out of the dialog. This is useful if you know where you want to place the pattern, and may be quicker
that placing it manually.

Editing Differential Paired Tracks (High-Speed option)
Editing the end of a paired track to add some more segments has been enhanced to work as follows:
In Select Mode, double-click on paired track end always edits the paired tracks (it used to depend on
if you picked within its width), and double-click on the connection attached to paired tracks will now
also do the same. Ctrl-double-click is new and will always enter the start new pairing mode (or
mirror mode depending on what option you have set).
In Insert Track Mode... this works the same as above. Click on connection or end of paired track
where it will edit the end of the paired tracks. Ctrl-click will enter the start new pairing mode (or
mirror mode depending on what option you have set).
This feature was back-fitted to V11.0

Design Calculators - Track Width Calculator Changes
Within the Design Calculators, a new check box has been added to the Track Width and Resistance
dialog. To the right of the Track Thickness controls, a check box named Adjust Result if not 1oz is
now available. If checked, it applies a correction to the formula for when the copper thickness is not
1oz copper.
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Reasoning
If 1oz copper thickness is plugged into the current formula, the results exactly match the IPC-2221
results. The basic principle is, a track that is 2oz thick has half the resistance of an equal 1oz thick
track, but almost exactly the same surface area to the board and the surrounding air.
If between 1oz and 2oz the resistance is halved then it is able to supply sqrt(2)=1.41 more current to
produce the same heat (P = I² * R ), but the surface stays almost the same, so the heat transfer should
be almost unchanged between 1oz and 2oz.
The current capability increase for equal temperature rise should therefore be very close
sqrt(copper-thickness / 1oz) . However, the IPC-2221 formula doesn't account for this as it only
appears to only be intended for 1oz thick copper.
Solution
To account for this, the calculation solution is to always use 0,035mm (1oz) for the cross-section
parameter, that the IPC221-formula requires, and afterwards the current is adjusted to account for the
different thickness by multiplication with the factor sqrt( copper-thickness / 1oz), or in metric units:
sqrt( t / 0,035mm).
Default Setting
This setting is now set to On by default but can be set off if you wish to revert back to the previous
calculation.
Reference
Mr. Haberzettl of FuG in Germany has very kindly provided the adjustment formula and has run
physical temperature tests to prove the correct results. With the corrected formula, the calculated
temperature rise comes much closer to his measured result.
This link was provided from him with a more detailed explanation:
https://www.adam-research.de/pdfs/TRM_WhitePaper2_TraceTemperature.pdf
This feature was back-fitted to V11.0

Panel Editor Changes
Set PCB Panel Origin Command
In a PCB design, a Set PCB Panel Origin command has been added to the context menu. This has
been added to enable you to set the PCB panel origin to a preselected item position instead of having
to place it manually.
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If you have a point selected in your design, a Pad, Mounting Hole, Construction Line junction for
example, you can use the Set PCB Panel Origin command from the context menu. This command
can also be used with nothing selected in the design, right clicking and selecting Select, then this
option. A point would then need to be selected for the reference.

When adding PCBs to a panel design it means this Panel Origin can be use to position the board to an
existing reference point, such as a Construction Line.

Min Copper Spacing for Tab Routs and V-Scores
Within the Panel Editor, with the Technology, Spacings dialog and under Additional Design Level
Spacing Rules, on the Panel tab a new spacing Min Copper Space has been added to both the Tab
Routs group and V-Score group.

This allows the definition of spacing between Tab routs and Copper, and V-Scores and Copper. The
spacing will produce errors when running the Copper spacing check in DRC. These new spacings are
taken into account when pouring copper (in the Panel Editor).
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New option to Create Tab-Route Around PCB Avoids Existing Tab-Routs
There is a new option on the Options dialog and Interaction page for a Panel design. Create TabRoute Around PCB Avoids Existing Tab-Routs.

By default, this option is checked (to Create Tab-Route Around PCB) so that it backed off from
existing tab-routs by the min breakout width (from Design Spacings). Unchecking this option will
allow the tab-routs to flow around the board with no gaps to the existing tab-routes.
This feature was back-fitted to V11.0

CAM Plot Changes
PDF Export – Plot and Combine PCB and Schematic designs
You can now combine a Schematic and PCB plot in the same PDF plot file.
To do this, you must first enable the Plot and Combine Schematic and PCB design option in the
PDF Setup option in CAM Plots. This setting is shared between both SCM and PCB applications, so
can be selected in either.

A new Plot and Combine Schematic and PCB design option has been added to the PDF Setup
menu in CAM Plots.
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With this new switch enabled. when run is pressed, the current design plots are plotted and a new
CAM Plots dialog opens allowing you to select what PDF plots you would like to plot from your
linked design.
The linked CAM Plots dialog is partially disabled to only allow you to select or deselect the plots
required. It is presumed that the plots would have already been defined in the design and at this stage
just require plotting, not defining. If the plot appears incorrect, then cancel the plotting option and
redefine the plots in other design.

Once run is pressed again, the dialog closes and the selected plots will be plotted and then appended
to the end of the PDF document created. You can do this either way around; SCM to PCB, or PCB to
SCM.
When running a combined plot, the program will either use the same name as the ‘other’ plot or will
use the design name defined in the Design Settings, Synchronise, Synchronise Design Name
option.

CAM Plot reports from both PDF plotting will be combined into one report.

PDF Export - Plot and Combine PCB and Schematic designs share Bookmarks
When using the Combine SCM and PCB plot feature, Bookmarks created will be also combined
provided the PDF Setup option, Bookmarks option is enabled.
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PDF Export - Combine plots by Group
Within the CAM Plots dialog and PDF Setup page, the Combine Plots into Single Document
switch has been replaced with a new Combine PDF option containing a drop-down list.

As with the old option, selections are still available for Plot All and Separately but this list now also
includes Group(s). This command enables you to combine plots by the named plot Group selection
for the plot.

PDF Export - Allow click on page link symbol to go to page
When creating a PDF Plot using CAM Plots, if your schematic design has page link symbol(s), then
clicking on the symbol in the PDF document will give you the option to Go To Page which will take
you to the linked page.

PDF Export - Selectable Hyperlinks
In an intelligent PDF document, for components showing their details, such as attribute values. If the
component has a <Hyperlink> attribute, you can click on this attribute and it will open the link
(provided it is valid).
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This is a feature which needs the option Component Details in the PDF Settings page enabled and
have a component with a <Hyperlink> attribute.

ODB++ Export Changes
There is a new switch on the ODB++ Export dialog, Include Multiple Board Outlines in the
Profile.

In the ODB++ format, the board outline is defined and drawn as a 'Profile'. Most ODB++ viewers
require the profile to be a single shape. Some ODB++ viewers have the ability to read multiple boards
outlines in Profiles.
Check this switch to enable the output of all board outlines in a PCB design to the Profile, if
unchecked only one of the board outlines will be included.
This feature was back-fitted to V11.0

Changes to IDF Output option
Option to not include Component Attributes
There is now a check box to enable/disable including Part attributes in the IDF output file. This option
is enabled by default. This is only available for version 3 IDF files as Part Attributes are not included
in version IDF 2.
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Remove Illegal Characters from Part Names
A new check box can be used to remove characters that are illegal in Part names for some programs,
such as Inventor 3D. They will be replaced with an underscore. These characters include: \, /, :, *, ?, ",
>, <, |

Change Units and Precision
There is now a Units option in the IDF output dialog. This means that where Units/Precision levels
different from your defaults can be used in the IDF output. The default design units can still be used
by selecting the Use Design Units radio button. Thou and Millimetres are the only unit options
available and match the IDF spec.
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Changes to Intelligent Gerber Import option
Save/Load Settings
The Intelligent Gerber Import option now has ability to Load/Save and Auto Save dialog lists and
settings.
Your current list and the settings within each dialog can be Saved and Loaded for subsequent use.
The new Clear button will clear the whole list.
The new Auto Save button will save the current list. When you reopen the dialog, those settings will
be recalled.

Import NC Drill file Only
The Intelligent Gerber Import option now now has the ability to read in just an Excellon NC Drill
file. This enables the drill positions to be verified.
Import BOM
The BOM file Import now recognises multi ref name format, such as D1 D2 D3 etc when defined in
quotes between comma fields.
The BOM file Import now also recognises the Pulsonix naming convention C[1-9] and will resolve
this to 9x individual component names, C1, C2….C9 etc.
Gerber files and G90 code
The G90 command (absolute mode) is now recognised when used in Gerber files.
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Vault Setup – Pre-check status for Vault Options
New Pre-check status for Vault options setting for use when a slow connection, such as a VPN, is
being used to access the Vault. Unchecking this setting stops a menu or toolbar from checking with
the Vault to determine whether or not a status specific option, such as Uncheck from Vault, should
be enabled. This avoids any undesirable delay in the display of the menu or toolbar.

Report Maker Changes
New command - Output to Excel
A new command has been added to allow the creation of Excel based reports.
The new Excel Command defines the report to be written in and saved as a .xlsx file.

This will export the report directly and open Excel:
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You can edit additional properties for the Excel output by double clicking on the Excel command
from the report script.
Checking the Auto Fit Column Width box will enable the columns to fit the data within it or leave
the columns at the default width defined by Excel.

New command - Output to PDF
A new command has been added to allow the creation of PDF based reports.
The new PDF command defines the report to be written in and saved as a .pdf file.

This will export the report directly and open your PDF viewer, such as Acrobat:

You can edit additional properties for the PDF output by double clicking on the PDF command from
the report script.
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From here you can change; The font and font size that will be used in the report, the overall text
alignment of the document, and the page size, selected from either a list of standard ISO formatted
page sizes (A0 – A5) or a custom width and height in either Point, Pixel, centimetre or inch units.
New command - Output to HTML
Four new commands have been added to Report Maker to enable the creation of HTML based
reports.
All the commands have additional options which can be edited by double clicking on the command
from the report script.
The HTML command defines the report to be saved as a .html file. Using this will force the report to
have the file extension .html. This should be placed at the start of the format script.
Double clicking on this command, you can browse and define a stylesheet to be used by the other
HTML commands throughout the report. This will be a standard formatted HTML CSS (Cascading
Style Sheet) file.

The HTML Heading Text command allows you to write HTML headings to the report, supporting
(H1 – H6).

From this command you can define; the HTML Class Name assigned to this heading (when a CSS
Stylesheet is defined in the HTML command), the Text that is to be written, whether to write in a
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New Column (tables only), whether this command is the last in the line (New Line after), the
Heading type (selected from a drop-down list) and the Alignment of the text in the HTML file.
The HTML Image command allows you to write an image to an HTML output report. Image formats
supported are: JPEG, TIF and BMP

From this command you can define the Class Name assigned to this image (when a CSS Stylesheet is
defined in the HTML command), the Path to the image, the Size of the image (either Auto Size or
manually specified Width and Height in either pixels or percent units) and the overall Alignment of
the image in the HTML file.
Note, with Auto Size unchecked, values for Width and Height must be greater than zero. If a value is
entered into at least one of these fields then the other can be zero, in which case, the image will be
size proportionally. For example, if Width is made 80%, and Height of zero (0), then the Height will
be 80% also.
The HTML Table command allows you to draw a table to an HTML output report.

From this command you can define; the Class Name assigned to this table (when a CSS Stylesheet is
defined in the HTML command), the Size of the table (either Auto Size or manually specified Width
and Height in either pixels or percent units), the overall Alignment of the table and the Border
thickness of the table (in pixels).
Note, with Auto Size unchecked, values for Width and Height must be greater than zero. If a value is
entered into at least one of these fields then the other can be zero, in which case, the default value for
the other will be used.
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Example Report
As an example of the possibilities for HTML, the following shows the format script and resultant
report in a web browser:
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New funciton - Text Variable Increment by 1
A new function for Text Variables has been added to the Report Maker. This new function will take
the string in the text variable and increment it by one. This can be added to your design as a User
Report to display a list of Variants within the design.

To enable this function, use the Edit Variable Command dialog. Assign the variable name to one
that is of type Text. In the Action list there is a new option (radio button) for Increment Text.
When enabled, this will increment the number at the end of the text by 1 or if no number is present
will add a number to the end of the text starting at 1.
This feature was back-fitted to V11.0
If Command – Case Sensitive option
You can now specify whether the comparison in a conditional statement should be case sensitive or
not. When editing the If command, it will display the Edit If Command dialog. There you will see a
new check box Case Sensitive. If this check box is checked, during relevant comparisons (e.g., when
comparing text) it will take character case into consideration. For example, when comparing the word
Hello and hello, it will be false if checked. If the check box is unchecked, then comparing Hello and
hello will be true.

New commands - List of Files and File Name
A new command, List of Files has been added to the Report Maker. When the report is run, it will list
all the files within a chosen folder.
This feature can be used, for example, in an inserted user report on the PCB design to list all the files
generated into the output folders by CAM/Plot. This saves you attempting to copy-paste the plot
names into a text item by hand, thus making the new process less error-prone.
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The destination can be edited by double clicking the command in the format script section. A folder
path can be added by:
Browsing a folder using the browse button
Typing in a path (this will benefit from relative paths, so folders within the design folder can
be selected by just typing in that folder’s name).
Reported using a script Variable
Whilst within the List of Files indentation in format script, another new command File Name is
available which reports the name of the file that is found.
Below is an example script showing how List of Files can be used. This includes the use of a
Variable to ask for user input to define the folder to report and the File Name command:

This feature was back-fitted to V11.0 and V10.5
New command - Is Land Suppression Allowed
A new command Is Land Suppression Allowed, has been added to support the new Land
Suppression override function on a Layer Class (documented above). When added to a report, it will
test and return true or false on whether the pad (bond pad or free pad), via or mounting hole has the
property Allow Suppress Lands enabled.
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New commands for interrotaing Symbol Library Contents
Attribute In Symbol Library
You can now run the Attribute In Symbol Library command from within List Of Symbols and List
Of Symbols to extract attribute information from within the Schematic Symbols or PCB Footprints
libraries in a design.
Is STEP Model Align By Centre
This new command will enable you to test and report if the STEP model has been aligned on a
Footprint in the Footprint library by the Centre or Pin 1. This can determine differences of model
alignment between the Footprint and the Technology file setting used in the Design.

The test can report a True status for aligned by centre or False if aligned by Pin 1.
These features were back-fitted to V11.0

Scripting Changes - New LoadTechnology Command
A new LoadTechnology function is now available for a Document object. Calling this function with
a full path to a Technology file name will load that Technology into the design.

Network License Server (NLS) - Send Message option
In NLSM (the NLS Manager application) there is a new Send Message button on the left-hand side:

Selecting this will open the Send Message To User(s) dialog:
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From here, you can choose one or more users from the list of connected Pulsonix users (or <All
Users> to message them all). Type in your message (and optionally the From box), and click Send.
On the client side, the Pulsonix application will from time to time have a look to see if there are any
message pending, and then display them on the screen. These messages are displayed in a popup
message box that is separate from the Pulsonix application so it does not block or interfere with the
normal operation:

